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1. Understand on Toolbar

1.1 Report Object
R Q T F=c A EE = [k EiEeo s = @ (2] 5 A2 28 1

Icon Name Description
h Object Selection | standard mode of operation : mouse cursor selects object(s), modifies
their sizes, etc.
My Hand allows dragging of whole report page
Q Zoom allows left-clicking to zoom in (adds 25% if already 25-75%, else adds
100%) or right-clicking to zoom out (subtracts 25% if already 50-
100%, else subtracts 100%) holding left mouse button while dragging
zooms in to selected area
T Text Editor allows in-place editing of “Text” object holding left mouse button and
moving the cursor creates and sizes a new “Text” object and opens its
editor
" ] Format copying | allows Format copying from one "Text" object to others: select a
“Text” object, click Format mode button, select Target "Text" objects
in turn exit Format copying mode by clicking any other mode button
= Band an area on a design page which behaves according to its type (e.g.
Header band, Data band)
A Text displays one or more lines of text within a rectangular area
=] Picture displays a graphic file in “BMP,” “JPEG,” “ICO,” “WMF” or “EMF”
format
& SubReport allows insertion of another report design page(New Page) within the
host page.
¥ System Text displays either system information (date, time, page number, sum, etc)
or aggregate values
¥ Check Box displays a checkbox with either a tick or a cross
ills Chart displays data in various chart formats (pie chart, histogram, etc.)
(4] RichText displays text in Rich Text Format (RTF)
a Draw displays a horizontal or vertical line and
" displays various geometrical shapes (diagonal line, rectangle, rounded
rectangle, ellipse, triangle and diamond)
(| Barcode displays data as one of several barcode types
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1.2 Align Toolbar

= o J|| _.J"..r _IJ| Ll "‘|E|‘-_*l:d

Icon Name Description
= Align Left align left edges (to first selected object)
2 Align Middle align horizontal centres (to first selected
= Align Right align right edges (to first selected object)
T Align Top align top edges (to first selected object)
i} Align Centre align vertical centres (to first selected object)
all Align Bottom align bottom edges (to first selected object)
i Space Horizontally space equally in horizontal direction
-] Space Vertically space equally in vertical direction
[#] Centre Horizontally individually centre each object horizontally in band
Centre Vertically individually centre each object vertically in band
— Shrink/Grow Width to set equal widths (same as first selected object)
Smaller/Larger
| Shrink/Grow Height to set equal heights (same as first selected object)
- Smaller/Larger
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2. Sales Invoice Bands
2.1 Understand on Bands

2.1.1 Group Header
- Grouping Header
- To Print on every page, right click on Group Header Band, select reprint on new page

2.1.2 Master Data

- The Main Dataset of the report
- Normally Bind to Main Dataset

- Each Page allows to have 1 Main Dataset Only

2.1.3 Detail Data
- To display all Item Details

2.1.4 Group Footer
- Grouping Footer
- Display on Last Page only

2.1.5 Page Footer
- Display on Every Pages
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2.2 Sample Layout in Design Mode

[CrOCpTIEage] Eo e T
r A

a4

|.
Invoice

Mazin. DocNo

Duplicate Copf

;Ellnc acictess
F[Mal'n.'Cumpa nylame"]
[Mzin.” Address1"]

[Mzin." Address2"]

[Main.” Address3"]

[Main.” Address4"]

(Fex [Main."Fax1T]

IDeimAcu'\"_"n

+
[Main."BranchMama"]

[Mzin."DAddress1"]
[Mzin."DAddrass2"]
[Main."DAddress3"]
[Main."DAddress4"]

[Msin. ‘DFanc]. ]

l—HﬂnI[Mah.'Athenﬁon'] n [Main."DAttenfon”] j
Tel [Main."Phonel”] Tel [M=in."DPhonel”] J

p—

Group Header

Master Data

p.wmuumn [Cel iz Eruir _I;.nrruw Ln._l_-nnuu ) [Froan D P _p.m. ey _l_ [
[Main"Code”] [Main."Agent [Main."C [Document_ [Dcl::urrent D [User"Co [E'Pﬁ]d [Main."Doc = [Main."Docl
|_ T i Lok J_J:n.r'ul 7] # -n.;u.%a’mmun_l.muq_

=
|
Document_Detail."FromDocNo”™

L~ it Sty |

F GroupHeade: | GrougHeats?
[Emrn Fime Blm o TPimm crnmnt Fumtns] "Eomma FomeRE~

Detail — Without Merge Same
Item Code

[

DetailDats: Detallalal

Thra]n Je— 1. "Mearri ] In ap T B —— rEﬁI_'—-..-.o ] . .

S A = it e b e (Tools -> Option -> Miscellaneous
1GelEN s Dooyment Del ] DIEy" = 1]

GroupFoote:: Grougfole? - Unticked)

['ln.lI‘n.c.—.v-..-JmFIMﬁ-nnlhm{"Mﬂ "Mearrirtinn|
[Mergealtan Cadea, "Dascriglion 3]

GroupFoste: Grugiute ]

TDoament_ "Damptnn"_l [CumencyTdangWord{=Man,"DocAmt'=, !
«Profile"Cumencylang™=]] k

L

Detail — Without Merge
Same Item Code
(Tools -> Option ->

TR{G=tTot=( |
'Fcrrnatha{{O
[ =AdiRourd.”]
[Msin, "LocalDoc

1A= Msin "CurrencyCode"|

[ A <Msin "CurencyCode"[

MR =Msin "CurencyCode"=]
1R <Msin. "CurencyCode ">

Miscellaneous - Unticked )

Pt e
[Msin."Terms"]

I_n:nulluu M

'I}:u.mert - Company, "ra.:Exerrm

et Joarz
[Mzin."DoRef1] '[Mzin."DoRef?]

Auilrmal Sl
oo "Coarys oy ] (TP resie. Trapstorhi ™)

Group Footer

PageFooter: Pagefonter Page Footer
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2.3 Sample Layout on Preview Mode

Y Testing Company-Demo

‘;{ Group Header

‘[ Detail

C/ Address is blank
Invoice
Billing Aodress Dinery Aodress
ALPHA & BETA COMPUTER
838 JALAN WORLD BIB JALAN WORLD
44ES RAWANG 404ES RAWANG
SELANGOR DE SELANGOR DE
Aftn MR ALPHA Aftn MR ALPHA
Tel 03-48573589 Tel 03-48573683
Faxx 03-485736320 Faxx  03-485736%0
Lailiater Aldiand =) P Ui il Frian D P Pl Pz Py [T [E®
300-A0002 MF 20/02/2015 DO-00006 S0 1of1l D-D0004 22/08)'
g dan Cols Ly miEgy L% Fregtin Sl To ol ()
1 M-85 PAPRLA S LU0 UnLl S50, 000 L0
2 N-B25D MNOKIA B250 2000 UNIT E20.000 1,780.00
RIMNGGIT MALAYSIA : NINETHOUSAMND THREE HUMDR ED & ND EEGHT ¥ OMLY Gmss 5, 380,00
- Drigcownit 000
Towl Bxd, Tax 9,380.00
T Ame @ 0.00
Rounding Adjustment 0,00
Tatzl Payabk Incl Tay| | 9,380.00]

Auth il S st
Tisatarng Coatysinty < Curmanl Lt ]

< Group Footer

2.4 Print Position

- Group Footer content will be printed at the pixel value input.

- Higher Value = Higher Footer

ﬁ Page Footer

- without setting with print position, the group footer will be printed after the document

detail records.
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- Example Source Code:
iIf Engine.FreeSpace < (GroupFooterl.Height + PageFooterl.Height + 30) then
Engine.NewPage;
Engine.CurY := Engine.PageHeight - GroupFooterl.Height - PageFooterl.Heigh

2.4.1 How to do the Print Position setting in Higher Value = Higher Footer
2.4.1.1 Click on Group Footer -> Click on Properties - rePrint
Event Name

E Fast Report Designer - Sales Invoice 8 (S5T 1)
File Edit Report View Help

~| Fparal -8 vBIU|TAmPl====]wwl
AT IR L e =TT =Y Bl & b9
: #l hag '|
KM QOFtAEiz dikE DS =@ (2] 5 A2 e
/ Code | Data | Pagel |

7 Wy | 100% v|

[
0

Report Tree (2] [ v 102030 40 50§ 708 0 9 101112013 0 14 45 0 16 0 17 1 18 1 19 1 20

“ < GroupFooterl ~ -

¢ e A Memol3 -

-~ /4 DBTxtInvAmt ) " - [ i ;
s Label1o - Invoice Duplicate Copy
- @;) Line3 - Billing Address TDdivery Address H
T P " T soom " 3
; Lines b Main."CompanyName"] Main."BranchName™] J
= - [Main."Address1"] [Main."DAddress1"]
- A Label3 o [Main."Address2"] [Main."DAddress2"]
-+ 4 Labels1 v B [Main."Address3"] [Main."DAddress3"]

H PR L[Mair1."Addressa4"] ‘[Mam."DAddress‘%"] !
< (Attn_[Main. "Attention"] TAttn J[Main. "DAttention"] ]
Object Inspector :Te\ jMam."Phonel"'I ITeI jMam."DPhonel"'I :

Fax [Main."Fax1"] JFax  [Main."DFax1"]
GroupFooter1: TirxG' 4pFooter ~ - = T, Brerutive Teurency Rate TFram Doc Dete | TFram Doc No Thiame Thage Mo Do M. T
+ + + + + +
- p Main."Agent"] [Main."C JDocument__[Document_D [User."Cod [PAGE] of |[Main."Do  [Main."DocD)

Prape Events " @ - n.“m; Placst. o Tew T Bl T Tax et Tote el Tex' Tax'

OnAfter ' (M), (M), (RM), Bate

OnAfterPrint - - )

OnBeforePn’rI IpFooter10nBeforePri = FGroupHeader: GroupHsaderl Document_Detail."FromDocho"

= 3l

- T HL[Document Detsil,'Description”] 1 TN Pnow Marmec fNncw Maciment 1 Maciment 1 TRnciment MNiacnimen/Dog

- Document,_Detzil."Desaipton3”]

- GetsM{<Docum ent_Detail,"DtiKey™>)]

- GroupFooter: GroupFooter?

o M [ MeraeIremCode."Descriotion”] [ MarnaTramy, [Marnafa,[Mer,

- [Mergel tem Code. ™D escription 37]

o FGroupFooter: GroupFooterl

- .

- ‘IDoaument_Currency."Desaiption”] : [Qurrency ToLanaWord(<Man. DocAmt’s, .
OnBeforePrint . <Profie."Currencylang">)]

- f Total Amount Due, "[FormatFloat,[ FormatFloat [FormatFloa, [Main."Loc,

b aymert Tarms. T [Ml Iwz I Tax sl Tekal Payatidd

- Main."Terms" Man."DocRef1" Main."DocRef2" FormatFloat in." "

Main." DocAmt’
= J L o e e J

Centimeters  1770.00; 16.20 119.96; 5.08 GroupFooterl

2.4.1.2 Adjust the value

procedure GroupFooterlOnBeforePrint (Sender: TfrxzComponent);
begin
if Engine.FreeSpace < (GroupFooterl.Height + PageFooterl.Height + 30) then Engin ANewPage;
Engine.CurY := Engine.PageHeight - GroupFooterl.Height - PageFooterl.Height
end;
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2.5 Stop Position vs Print Count

Stop Position

Print Count

Details will stop at the input value

Details will stop by number of records
inputs

Recommend

Not recommend if using More Description

Value in Pixel

Number of Records

2.5.1 How to do the Stop Position in Report?
2.5.1.1 Right click DetailDatal -> Click on Events Tab -> Double click onAfterCalcHeight name

File Edit Report View Help

~  "HpTahoma a2

'BIU|TE1"1 |___= ;‘I\-‘ Ilf l"“

OnAfterPrin

_ =TT L |w\ll..,\ « Dl
| -
k@@ﬁfaalﬁzlﬁl]mmu@-lmﬂdw
/Code | Data | Pagel ',
Report Tree [z2) vl 200 3 0 4 0 85 0 B 0 T 08 08 010 11T 1200 13 0 14 0 15 0 16 0 17 0 18 1 19 0 20
w -1 DetaiDatal ~
- A Memo7 k - I i ;
Duplicate Coy
¥ SysMemol Invoice p py
A Document_DetailQty Billng Address Deivery Address H
-~ /& Document_DetailUnitPri :IMain.'Comnanvllame'] :lMa'm."BranchName"I _1‘
} - ; [Main."Address1"] [Main."DAddress1"]
A Document_Detaf\UDM [Main."Address2"] [Main."DAddress2"]
- A Document_DetaiDISC [Main."Address3"] [Main."DAddress3"]
A Document_DetalAmayr ., [Main."Address4"] _[Main."DAddress4"] !
< L cot - > :Attn:J'Mam.”Attentmn"'l Imtn :IMam."DAttentmn"'I :
J

;Tel :J'Mam."Phonel"l
J[Fax [Main."Fax1"]

Customes Accout,

TMain."Code ‘[Main."Agent"]

ITeI :JMam."DPhonel"'\
JFax [Main."DFax1"]

Tewrency Rae TFrom Doc Date Fram Duc Mo Toaga Mo
+ + + + +
_[Main."C _[Document__[Document_D [User."Cod_JPAGE] of

Tilame: T

Doc Mo
PR P
Main."Do , [Main.”DocD)
Ts\l'nl Totdl Tl Tad'| Tax'

By Rate, |

il Main

Toses Evecutive

L on N . Tl Bk T
PricejUit Discost S Tt e

Qy

OnBeforePrint DetaiDatalOr
OnMasterDetal

Mz v 11 100 9 1 8 1 7 0 B 1 51 413

OnAfterCalcHeight

19 018 A7 v 16 0 18 0 14

Centimeters  1170.00; 12.30 1719.96; 1.32

2.5.1.2 Setting the stop position

procedure DetailDatalOnAfterCalcHeight (Sender:

begin

I// Example Stop position on 9.5 inch * 96 = 912
.Visible and

if TfrxDetailData (Sender)
end;

2.5.2

Document_Detail."FromDocho"
nniment Netail "Eroml,

. Document_Detail

. 3
T IPanMNn Maima Maa L INaciment © INacimant © [RncmentL [ Dneimen Deg

MergeltemCode

TMMemea, TMarm [Marnae [Maray [Maraeiram, [Mernalter, [Mernaltermy, [Merae e Mes

{11 7] MeraeltemCode, Descriotion]
[Mergeltem Code. D escription37]

*GroupFooter: GroupFooterl

r[Dn ament_Currency."Desaiption”] : [Currency ToLangWord(<Man."DocAmt"s,
<Profie."Currencylang"=)]

L

Total Amount Dug, "[FormatFloat,[FormatFloat, [FormatFloa,[Main."Lo €

L
ayment Terms : Ee' 1 Iw 2 T Tax n\muu Tekel Py
[Mam Terms” [Man."Du(REfl"] [Man."DocRef2"] [FurmatFIuat [Main.' Mmt"
a4 +
Ir.u Exemption 83 | +

Rathrseiene] S

DetaiDatal: Document_| Deta‘l

Frrxcomponent) ;_

(Engine.CurY + DetailDatal.Height >= 912) then Engine.NewPage;

How to do the Print Count setting in Report?

2.5.2.1 Right click DetailDatal -> Click on Events Tab -> Double click onAfterCalcHeight

name




SAD\ Fast Report Basic Guide

EIAGET

e, SOIL, com.rmy

File Edit Report View Help

~ | TpTahoma v9'B[U‘Tl‘ |

I TR NIRRT Ak, | 100% =
palogEl dass o
A0 Q 13};AEIEEI]3IE.£\E\|;|@- =) r CL
/ Code ! Data | Pagel |,
Report Tree @ |l1l2l3\4l5l6 T8 09 00 e AT 0 120 13 0 14 0 A5 0 16 0 17 0 18 0 19 0 20
v -1 DetalDatal Al =
A Memo?7 - F . - =+ . =+
£ SysMemol - Invoice Duplicate Copy
/A Document_DetaiQty - Biling Address Delivary Addrss M
— H = 3
A Document_DetailUnitPri b JMain."Companvhame"1 JMain."BranchName"] J
- - [Main."Address1"] [Main."DAddress1"]
A Document_DetalUOM o [Main."Address2"] [Main."DAddress2"]
| ain. ress ain. ress
A Document_DetailDISC _ Main."Add 3" Main."DAdd 3"
A Document_DetailAmeyr ., [Main."Address4"] _[Main."DAddress4"] !
oo 5 (Attn_[Main. "Attention"] TAttn L[Main. "DAttention"] ]
:Te\ jMam."Phonel"'I ITeI jMam."DFhonel"'I :
[Fax [Main."Fax1"] JFax  [Main."DFax1"]
i Lt TCirency Rale TFrom Doc Dae  Fram Duc Mo Nane nsge ™ Do Ma. T
: +
DetalDatal: TirxDetalD lain. CJDocumntJDncurlent D Jllser "Cod _,[PAGE] of |[Main."Do_ [Main.”DocD)
fProperﬁesIEvents( I S et setas T4 M(T:ﬁ T’fmy m‘m&:’ ;
OnAfterCalcHedatal OnAfterCalcHelg! - 1)
OnAfterPrint - = ";""'P“eade' Groupheadst Document_Detail."FromDocho"
OnBeforePrint iDatal0nBeforePrint | - iL" il - iL"
OnMasterDetar—————+—+ @
[ — | N Mo[Document Detal,"Descriotion™] 2 MNaaw Minaw Marima Mincw Marment 1 Mincoment 1 TAncoment MNacnmen,Dog
Document,_Detzil."Desaipton3”]
iy GetSN{<Docum ent_Detall."DHKey™=)]
- GroupFooter: GroupFooter?
- il
w 1M [MeraelternCode."Descriotion’] LMeme, [Marm, TMaraeTra, [Marn, [Mernaltern, [Marneltam, [Maraeltam, [Marnafa, [Mes
- [Mergel tem Code. ™D escription 37]
o FGroupFooter: GroupFooterl
- r[Dcu:umentﬁl]Jrrency."l:!escnptun‘j : [QurrencyTolangWord(<Man."DocAmt" >, .
. <Profie."Currencylang">)]
OnAfterCalcHeight - f Total Amount Due, "[FormatFloat,[ FormatFloat [FormatFloa, [Main."Loc,
b Rmnul Terms. 1 CM 1 Iw 2 M Tax !uuu.ll Tewsd M‘“ﬁ
- [Maln "Terms" [Man."Dn(REfl"] [Man."DocRef2"] [anlatFk)at [Main." DocAlnt
J i, .
= I’ax Eempon | Aubhadisad Sonshad
Centimeters  |70.00; 12.30 1719.96; 1.32 DetaiDatal: Document_| Detai

2.5.2.2 Set number of records

procedure DetailDatalOnBeforePrint (Sender: TfrxComponent);

begin
DetailDatal.Visible := <Option."MergeSamel
DetailData2.Visible := <Option."MergeSamel
l
// For Print Count 20 , 4
ﬁf TfrxDetailData (Sender) .Visible and (<Line#> mod 20 = 1) and (<Line#> > 1) then Engine.NewPage;
end;

Small Tips :

i) Set Either Print Count or Stop Position

i) use // to disable the command

iii) When you set both Print Count and Stop Position, system will capture Print Count.

10
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2.5.3 Sample on Print Position / Stop Position

) Testing Company - Sample Report _
s Ho 1, 2nd Floor, Jalan Setia Dagang AK UL30AK, Setia Alam, 90170 Zhah Alam, 5elargor, Malaysia.
{1 %" Plome: 0373501300
Tax Invoice
Alirg kowes: Dot betr  Beor =
TEET Coslra
Akn Akn
Tel Tel
Fax Fas
[Fr Ty Ao Sonaec [T ) L Dac)
ANFTINNOT -—- AN lafl Tw-{N1 00 11710/ A
R— o R b Edrermen raded s
1 AEHS 100 UHIT 4,001,000 4,008 00 A,00100 00D 40000
Stop Position - Calc from Top
to the arrow down
IT BAALEYSTA : FOUR THOUSSHD A0 CRHEO MY
Tatal Arrecamit D A,001,00 A1,001,00 000 4000
[T |-A—.-Lﬂ'| |um|_
L 0.0 4,001.00
il SEauc
. .. ek ey - S i P 0
Print Position
- Calc start from the Arrow up
|

11
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3. How to design Simple Sales Invoice?

=> i) Preview Invoice
=> i) Click on Report Name to enter to Design Mode

= o B CAEEE R B @ ] .

(&

Invoice

Dby A
DELIVERY

Atn
|
ax

— o - :j
ADMIN  1of1 00007 _25/10/201
Rt Ducors A Tas  TMBGTE o

ar ]
1000. UMT 500 500000 500000 000 500000
]

100 UMT 50000 @00 0000 000 9000

3.1 Add PICTURE

3.1.1 Click on Picture Object
[ | = s |k
mEEE e o
RO Q T = A (1 2 ] il (] L & & ) @ e (2] 3 A 2T 1
{Code {Data Paget |

| EFE| 4 Dih9 \H%|1oo%v|

3.1.2 Place on Report Page

Main."DocHa"
] =1
[ |
W o,

i) Fix Picture

12
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3.1.3 Click on Load

Bae|lxvs

284x177

3.1.4  Select the Picture on your local drive

3.1.5 Clickonv

3.16

ii) Capture Picture from Report Dataset

13
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/ Code ' Data ?Pagel\

Repaort Tree ) P10 2 0 3 0 4
...... @ Picturel ~
Rich1
...... A Memo55 B
...... A Memo56 _
...... A Memo57 _
...... A Memo58 o~
...... A Memo59 _
------ A Memo60 » o
< > -
=t
Object Inspector ) - :_mm,.,g Address
Picturel: TfrxPictureView v| [Main."CompanyName
- [Main."Address1"]
- ) - [Main."Address2"]
e o Rl
: [Main."Address4"]
[#Anchors [fraLeft,fraTop] r~ Fat ' [Main. "Atte ntion"]
AutoSize [ False ) I-'I'»al +[Main."P'h onel"]
Center [ | False P+ in."Fax1"]

Cursor
DataField
DataSet
Descriptio

3.2 Text Memo

Logo
Profile

- Add Customer Email Address
3.2.1 Click on Text Memo

= f

el | |

I

[=]] == &1
R

DEEHE | B & |

| 2 s 100% ~|

SERERE i offE

3.2.2 Place on Report Page

& & = @ o 5] 5 A2 =0 m

14



SAD\ Fast Report Basic Guide
i Account "\, Payroll

e, SOIL, com.rmy

3.2.3 Enter Text : Email

& vemo [m] X

Text Format Highight

= 3

Email : _—

A

i}
[[Coc || cwer

3.2.4 Repeat Step 3.2.1 & 3.2.2
3.2.5 Select Document_CompanyBranch -> Email Expression

Az 2 & expression Editor - (] x
o /bata {variables'{ Functions | Classes |
=
- TE | EE o
| [:8] Attention -~
| | -[0] Phone1

[28] Phone2
[

Document_DocProject

<Dacument_CompanyBranch."Email"=| I
| e (i Prossiok )
5

LTRAET A T TR neimen L Mneiment L P et rimenioe |

3.3 Rich Text Object
- Add Note
3.3.1 Click on RichText Object

DETEY: 3%;\@52 I]a!ln.ﬂmml;l@

3.3.2 Place on Report Page
3.3.3 Select Main -> Note

@ Expression Editor - o X
DataVariables | Functons | Casses

@3- | 1miE | BR Pk

9] OFax1
0
m’ ”
<Main. Note">] _

{fanDockatt] “an-ockez) | O

Total Amount Dus. IF
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3.4 System Text
Add Sum Qty
3.4.1 Click on System Text Object

S e 2l 2
A amQ T o= a 2 AE 2 =2 [y

/ Code { Data | Pagel '

W 18

3.4.2 Place on the Report Page
3.4.3 Select Aggregate value

System Memo bt
() System variable

Aggregate value

Function |sum

Data band |DetaiDatal
DataSet |Document_Detai
DataField [on

Expression

[ ] count invisible bands

3.5 Draw Line
3.5.1 Clickon Line

HEHE DS a2

R MQ T FAEEE 4

3.5.2 Place on the Report Page

16
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3.5.3 Drawalline

I-F!ﬂluul. Terms
L[Main."Terms"
Trax Bvemption M |
L[Document_Compmy."‘l’axExemptN

Ther 2

"Rel 1 ¥
[Man."DocRef2"]

g
[Man."DocRef1"]

[N

T T= Ao, Total Pe:-,ﬂ.lg
[FormatFloat [ Main."” DocAmt"

3
4
a

.

L=t

=1

[Main"Mote"]

3.6 Center Horizontally in Band

- Display the object in center horizontal
3.6.1 Click on Object you want to show in center horizontal
3.6.2 Click on Center Horizontally In Band

Noste = HTahoma -1 ~BI/U|BAmP(====mw
TR ET) O R REERE R T AL R A

| &0

2 =

P

1

-

R QT =c A @ E ¥k E GE

/ Code | Data | Pagel |,

CEFREES (5] 10203 0 40 5 0 B 0 T 0 8 1 8 0100 110120 130 14 0 15 0 16 1 17 0 18 1 19 1 20 o
o A Memos9 ~
e Ay Memo70
A Memo71 - *GroupHeader: GroupHeaderl Main."DocMo™
‘e A MmDuplicate _ rlE‘ f =
A Memos7 - |
2] Picture2 -
A Memo72 - b
o A Memo73 v = ;
< > - 5 g . . 2
- slnvoices Duplicate Copy
Object Inspector @ - TEiling Addrass “Daivary Address H
|Mem067: ThrMemoView v| “ J Main."CompanyHName"] JTMain."Branchlame"| i
- [Main."Address1"] [Main."DAddress1"]
[Bronarties  Euante| £ [Main."Address2"] [Main."DAddress2"]

3.6.3 Done

17
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3.7 Align Left / Middle / Right

3.7.1

3.7.2

Click on the multiple Object to Align as same alignment. System will follow the first object
as alignment
No style > FpTahoma -7 B I U|BHAm@P|E
Tt el ENILECCED R

| L |
B R R & 09 |ZE{%|100%-|

Report Tree B 8 19 10 0 11 120 13 0 14 0 15 0 16 0 17 0 18 0 18 1 20
A Memo24 ~
-~ &4 Memo25
- A Memo30 B FGroupHeader: GroupHeaderl Main."Docho"
A Memo31 - Ly u
£ Line9 _ E
-+ A Memo32 o~
A Memo33 -
A Memo34 o ]
< T > - - [ E
| .
Object Inspector - iling Addrass
Memo24: TirxMemoView v | “ Main."CompanyName”]
- [Main."Address1"] o
" . [Main."Address2"] [Main."D:
/Properties | Events', - [Main."Address3"] [Main."D;
Align baNone ~ L [Main."address4"] [Main."?
. ;- — £
AlowExpressio v True _ JAttn [Main. "Attention"]
AlowHTMLTag: | False - Tel [Main."Phone1"] - -
AlwairrorMocD False Fax [Main."Fax1" LEma\l: JLDEEJ_r‘rent_Cumpanyﬂ'and’]. l
AlowVectorExjlv True B Tustomer Accowt TSakes Executive Teurency Rate From Do Date | TFram RS Touge D Mo T
Anchors [fraleft fraTop] = fMain."Code f[Main."Agent"] “[Main."c ‘[pocument_“[Document_p user."cod [PAGE] of J[Main."Do” [Main."DocD]

Done
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3.8 Save the File

1. File -> Save As -> Enter Report Name -> Save
2. Preview and see the result

Result:

19
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Biling Addess
AB ENTERPRISE
48 FLOCR MENARA
N 38 JALAN TANG)
43587 PETALING J&
SELANGOR

Altn MR ALF

Tel 03-43380578
Fax 03-45380550

i Poga P Cnt his. =
300-A0003  NF AN 1ofl N-00007  25/10/2019
Pay D g oy ProgiUint Do ot Sy Towad Iumﬂl;: '“3‘::" IanJ.ﬂ::: IL':

1 MOTOLORA RADIUS GPI0D 1,000, UMIT 5.00 5,1000.00 5,000.00 0,00  5,000,00

L]
2 MNOKIA 32D 1.00 UNIT  S00.00 S00.00 S00.00 0.00 D000
NIMNE HLUMDRED ONLY 1001

e 5900.00  5900.00 0.00  5,%00.00

Tis Arruaat (UM Tkl Py e (0]

0.00 5,900.00

Auginyreial Sap ue
Timitwng  covysny (]
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4. How to create the Subreport in Report?

-> Preview Invoice

-> Click on Report Name to enter to Design Mode

&SN EBAFEEEE A~ HR

4.1 Click on Subreport Object
D EEE T iEE R 4
S L :
ROQTF=tam 4O ik

———

i ul

=

i F | @] =

4.1.1 Place on Report Page you want to show.
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F - ) -
Invoice Cuplicate Copy
Billing Address TDdlivery Address H
;-]'Main.“l:umnanvl\.lame"'l :]'Main."Branc:hNamE“] :
[Main,"address1"] [Main, "Daddress1"]
[Main."address2"] [Main."Daddressz2"]
[Main, "Address3"] [Main, "Daddress3"]
I_[l‘v'hslin.”hddressdf"] J_[Main."thdressﬂt”] |
W [Main, "Atention"] TAtn Main. "Dattention”] j
:Tel :IMa in."Phone1"] :Tel :IMain. "DPhone1"] :
Fax [Main"Fax1"] JFax [Main"DFax1"] J
E:mmme.&mm ISaI:i Enmofie :c“..e..:, Rae Ir.um D= Date :Flurn D= Ha Iﬂame :Va; [ Do W : Dt
IMain."Code [Main."Agent™] [Main."C _[Document_ [Document_D [User."Cod [PAGE] of |[Main.”Do  [Main."DocD
Mo Dmcimion o PrimiUnt s, Sun Tal Tl B T Bl il W
*GroupHeader: GroupHesder2 Daocument_Detail, "FromDocko” |
Etrrn Mine ko s [Mocorment Detail "Srorofiockin®T Froon Doc Date o [Dooorment Detal "Erordh
N IDocument Detail, "Descridtion”] L = L 1w M et L Mec et o THee resd TOne ireeu[Cog

Docurment_Detail."Des ariptions
GetsSN{<Docurm ent_Detail "Delkey" =]

GroupFooter: GroupFooter?

N MeraelternCode. "Descrittion™ 1 L MWerme, Thsrm, ThermeTtey, Mern, ThsrmeTterm, [MernsThern, ThsraeTherm, [hermeTta, [Mer
[Mergeltem Code."D escription3"]

4.2 System will prompt a new blank page for Subreport

Ciocke st Pl
bl e T Trid L | FRLEE B LR Boe B0 07 12 03 o nd 0 1 e e e AT e 00 e 19 0 3
Fagal: Thafaporiage ~ SE A Hemodl A
| y A Hemod:
Propertes | Evarts Ll A W B
BakPriae  (hotssagned A A Memas -
EacFohunrmt v True A Hemas
B P reS v Tros A Hemas -
BakPetravsbiv True A Hemos
EctiomMargn O A el -
ko Moo A Memos
Columes ] A Hemas -
DataSet ihck: assignest A Hemall
Do ik A HemoE ™
Ervdens-gt Faine | menrat
Endessivicth | |Fase \a] At ™
Erart Tront) A Memog! -
- Frame (TEuFrame) & Wi ™
Largalesign-wa v Tns A, HemaE: -
Lefbrgn 039 A Memag | 7
MmorMargns | |Fase A Her o
Errordack ] A HemaE!
Mame Fagel A Memog a
onantbon  poPOITaE A WmTad =
CutirsTest A Hemoel =
Fagptort L T Syiber -
Papartiaght 2754 A, HemoE: bl
Faperre Letter A Hemam
Faperifhch 2155 A Hemal 2
PTGty W T bl A MmCup
A HemE
Lk Subreportl |
| Fagez w| T
< > -

4.3 Click on Insert Band to design the layout or insert the data




sal\
 Account N, Payroll W

e, SOIL, com.rmy

Fast Report Basic Guide

)
Report Title
Repart Summary
Objert Inspactor Pace Header e Vo 2o 3 0 4 0 5 0 B 0 T 0 8 0@ 100 1 12 0 13 0 14 0 15 0 16 0 17 0 18 1 18 1 200
Page2: ThxReportPage Page Footer :‘ 2
Heacer s
BackPicire  (Wotas Footer S -
BackPictrePTint VI TIUe [ paster Data 5 _
BackPictLrestretw|Trug i 5 -
BackPicturevisibl v/ True Ll i 5 -
BottomMargn O 1 Subdetail Data 5! o
Color MclNo| (5 Data 4th level E -
Columns s . S i
Dataset (Mot a5 1 Data 5th level < _
Duplex dmien| 2 Data &th level o r
EndlessHeicht [ [Falsg =2 Group Header 2] -
Endlesswidth [ |False Brenp Faiar ‘f‘
[#IFont (TFont; Bl
[Frame (ThFr Child 3 ~
LargeDesigriHeig v/ True Column Header & -
LeftMargin 0.99 Column Footer & ®
MirorMargins [ |False B
[EIMirrerMode 0 vy 6! 7
Name Page2 Vertical bands (S =
Orientation poPorirar 2T axt -
OutineText A Memott =
PageCount 1 T Sysher z
PaperHeight  27.94 A Memog o
PaperSize Letter A MemoTt -
Paperwidth 21.59 A Memo? bl
PrindEmpty W True v A MmMDUp -
...... A Memos =
Esubreportl -
| Pagez v 7
< > -
Centimeters  T7-042; 0.16 Page2

**May refer 2.1 Understand Bands at Page 4 on what band to use
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5. Check Box

5.1 Simple CheckBox
5.1.1 Click on CheckBox object

File Edit Report Yiew Help

D= Ed| [ EE e | T ot oll | o F | ()]

[ [ w ow o b-o -
R QT A E LD Bom = @ o 5] 5 A2 e m
/Code | Data | Pagel |
Ohject Inspector (2] | Report Tree (=) vl 2z 30 4 0 & B 0 708 0@ A0 0 1 012013 014 0 15 0 16 1 17 1 18 1 19 1 20 1 21 1 20
‘Pagel:Tﬁ'xReporiPage v| v | | Page1 ~
v -3 GroupFooter 1
Properties |Events p - A Memol3 B MGroupHeader: GroupHeaderl Main. "Docho”
BackPicture (Mot assigned) A A DBTxtnvAmi| - ’E‘ £
BackPicturePrint v True - /4 Label10 -
BackPictureStret W True g? Line3 o~
BackPicturevistl wi True Z LineS -
BottomMargin O A Labeld3 b
Color W cihone A Labels1 - - R n - ‘ N
Colmns o - A DBTextz3 - Invoice Duplicate Copy
DataSet (Mot assigned) A bRefl - Eillng Address TDdivery Address H
Duplex dmione ~ A DBText101 o IMain."CompanyName"1 IMain."BranchName™] T
EndiessHeight [ |False A IbRef2 - ‘:gg"esséq ma‘ iggre“;q
o "tcidress2" Ell ress2"
Endlesswidth [ |False -~ A DBText1d - [Main *Addrege3) [Main "Diddrass 3]
[FFont (TFont) A VarPayAmt 8 [Main."address4"] [Main."Daddress4"]
s e = 3
[:JFrame (ThrxFrame) & Lines 2 At [Main, "Attention"] SAtn Main,"Dattention "1 1
LargeDesigriHei; W True A Labels1 [ - Tel JMain.'Phonel”] Tel JMain.'DFhonel”] 1
LeftMargin 0.99 &7 Line7 Fax_[Main.'Fax1"] JFax_ [Main.'DFax1"] 1
MirorMargine | |False - A Memo - Etome s o it L T T e o T
EMirorMode 0 A Memoll [Main."Code Man "Agent”] [Main."C [Document_ [Document_D [User."Cod [PAGE] of [[Main."Do ;[Main."DocD
Name Pagel A Memol2 o ) T m | e v seres TSR TemmlTmimel e
Crientation poFortrat A Memold -
QutineText - A Memols -
PageCount 1 A MmTaxExem| - = Ao 0
Papertegt 274 - Aooumenc | o | s
PaperSize Letter = MasterDatal - a rNJBc(umgqtt gsgi\.‘:;g)esmugunél] L Par L IPar e Mine rec Mo i Moeoment & Moriment - TR ment2 1Pne ime Do
Paperyidth 21.58 v -9 DetalDatal o Ggf;nrl?w&um‘ent,ﬁeﬁﬁ“nﬁlkey“>)]
PrintifEmpty W True v - A Memo7 -
GroupFoater: GroLpFacter2
E SysMemol z
~A Document O o f “Degriotion” mo [ f f f T rl i
A Dooumentic v | 2 e JNS;SSIIE.T&EE“ r??iﬁ',’?ﬁ'gn”al] TMiewney, Mipre MsrmeThey MusrrL MiBrnaTfer MeraaTtern, (Mermeltermy. Misrasire Men

5.1.2 Place on the place you want to show.

24




SAD\ Fast Report Basic Guide
i Account "\, Payroll

e, SOIL, com.rmy

P H N al
Invoice Duplicate Copy
Billing Addrass Ddivery Address 1
;—IMain.“EumnanvName"] “TMain."BranchName" 1 :
[Main."Address1"] [Main."Daddress 1]

[Main."Address2"] [Main."DAddressz2"]

[Main."Address3"] [Main. "Daddress3"]

L[Main.”:ixddresscl”] JMain."DAddress4"] |
At [Main, "Atention"] At Main, "Dattention”] i
;:Tel :IMa in."Phone1"] ITeI :IMain. "DPhonel"] :
Fax [Main."Fax1"] JFax Main"DFax1"] 1
:Cusu:mel e IS:IB Exmofive ICulleru:r Rt :Fluln Do Doy :Fluln D W INdme Ipage a Doz o, : Lo}
[Main."Code [Man."Agent”] [Main."C [Document__[Document_D [User."Cod [PAGE] of |[[Main."Do . [Main."DocD
Mo Dmmigon . oy | iU Daomn. S Tt Total E‘"'(I;“;I T= ?'::U. Toral kli;\r:J. ;

N aDocument Detall, "Descriotion”]
EDIILJI'ﬂEﬂt_DEtaIL Desription3"]
GetSM{ <Document_Detail "DHKey" =]

GroupFooter: GroupFooterz

1T MeraelternCode,"Descriotion™]
[Mergeltem Code,"D escription3"]

L Merne, Thsrm, MierneTrey, Tisrn, MierneTtern, [heensTtenm, erneTtenn, Thsrnethe, [Mer,

|'GroupFooler: GroupFooterl
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5.1.3 Press on the button

Ohbject Inspector [22]  Repart Tree =) Vol 203 0 4 0 B B 0 T B a0 1
‘CheckBoxl:TﬁxCheckBoleaw | |-l checkBax1 ~

5
2
=
2
z
=
s
=
"
=
-

| PageFooter 1
/Properues YEvents\ ‘;:' | DetalDataz YeroupHeader: GroupHeader1 Main, "DocMo"
Align bakone A - E SysMemo2 - E‘ il
MlowMirrorMode || False - A Wemol7 _
AHowVectorExch]True A Memozs ~
[FHanchors [fraleft,fraTop] - A Memo27 -
CheckCalor M clelack A Memo23 o
Checked WTrLe A Memoz9 - v . - - ‘ =
CheckStyle €sCross - A MemolQ =+ Invoice Duplicate Copy
Color M clhione A Memols - Billing Address TDalvery Address T
Cursor crDefault - A Memold o :IMa ‘CompanyName"] :IMain MBranchName" ] 1
DataField A Memold - [Main."address1"] [Main."Daddress1"]
@ [Main."Address2"] [Main."DAddress2"]
DataSet (Mot assigned) RichDesc3M [Main."address3"] [Main."Déddress 3]
Description - A MmDesch [Main."Address4"] _[Main."DAddress4"] !
[z|Editable [fer AlowrPreview] Tatth [Main. "Dattention"] 1
Expression Tel TMain."DPhore1"] 1
=IFill (TfrxCustomFily JFax [Main."DFax1"]
FilType fiErush P Touremy e hom G e e b s T oo e N
CFrame (TixFrame) | i - A Memo21 o ode jMa‘n."Agmt"] _[Main."C _[Document_ [Document_D [User."Cod JPAGE] of |[[Main."Do , [Main."DocD
[ZBottomLine  (TfxFrameline) i Lines = T Vicmtiot Bt Sa T T E‘"({;;T I= f;;;' [Teeal "‘“{;‘; R
Color W clelack - A Memo23 _
DropShadow | |False A Memo24

. Docurnent_Detail. "FromDocNo”
eftline (TfrxFramelineg) A Memo25

[

ightLine (TfrxFrameLing) - A Memo30
ShadowcColor Il clBlack A Memo3l i madlDocument: Detal, Descriotion™] i w. Inam W inam L Mina mes Maew IDes et ©Meeiment 1 Ionm et MoeireedDog
Shadowwidt-4 - Line @ Gg‘t:?’\ll_‘E<DEEumtlént7§EEﬁ‘ﬁ‘ ey sy
Style —— fsSolid V|- A Memo3z2 -
Frame A Memo33 : GroupFooter: GroupFooter2
The frame attributes of the object - A Memo3d “ TN T [MeroeltemCode . "Descriotion1 TiMerme Misrr (Marnsttey MarrL MMerneTenmy MerneMerm Mernat termy, MisrrsTre Mer
A Memo3s A [Mergeltem Code. "D sscription3]
< b4 w [*GroupFooter: GroupFootert

5.1.4 Select the frame design
Frame Edito

Line

Choose the line style, then choose the line to apply the style.

o ][ o
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5.1.5 Change to False

/Code ! Data /Pagel |

Object Inspector [%2] Report Tree 5]
‘CheckBoxl: ThxCheckBoxView CheckBox1 A
|l PageFooterl
Properties | Events | & | Detipataz
Algn baklone
MlowhirrorMode [ | False
AlowVectorExpc v True
[#lAnchors [fraleftfraTop] .
e Al Bl A Memoz28
A Memo29
Eeasc CECross - A Memol0
Color M clhione A Memols
Cursor crDefault - A Memols
DataField A Memol9
Dataset (Mot assigned) RichDesc3mM
Description A MmDesch
[FEditable [ferAlowInPreview] | GroupHeader2
Expression A Document_Det
[=IFil (Tfr<CustomFil) | GroLpFooter2
FilType fiBrush | GroupHeader1
[=IFrame (Tfr<Frame) A Memo2l
[FBottomLine  (TixFrameline) - LineB
Color W cBlack A Memoz23
Dropshadow || Fake - A Memozd
[FILeftine (TfrxFrameLine) A Memazs
[FRightLine (TfrxFrameLine) - A Memo30
ShadowColor Il cBlack A Memo3l
Shadowwidtt4 & Lines
Style —— fssolid v || A Memo3z
Frame A Memo33
The frame atiributes of the object " A Memo34
A Memo3s A4
< >

5.1.6 Save the File

9

T

6 018 0 14 013 012 0

10

V1200130

VeroupHeader: GroupHeaderl IMain, "Docho"

4 -
Invoice Duplicate Copy

Billing Address
Tmain."CompanyName" 1
[Main."Address1"]
[Main."Address2"]
[Main."Address3"]
L[Mam.”Addresstl“]

At [Main,"Attention"]
;TE!\ :IMain"'Pthel“]

Fax [Main. "Fal"]
[CRp— o o

iMain."Ende j[Ma'n.“Agmt"] j[Main."E JanthentanﬂmenLD j[LIser.“Dnd jPAGE] of |[Main."Do t[Main.“DntD

Deliveny Address

:[Main MBranchName™]
[Main."Daddress1"]
[Main."Daddress2"]
[Main."Daddress3"]

JMa\n.“DAddress4"]

IAt(n _,YIMaln‘ "DAttention"]

Tel IMain. 'DPhane1]
JFax [Main "DFax1™]

Thiame

o e Ty far Thm B baz | T O o 1 N

" i | bmctac I J—y T . Toal Bl T T Tonal Tl Tas! Ta,
Ha  Dmzimon ar ZENAT Sun Toral am, o, m, niee
MasterData: MasterDatal  Main

GroupHeader: GroupHeader2
Erarn Do ba [Necument_Detal FrormOocbin]From Das Nate + [Nonrment Detal "Erard
'DetailData; DetailDatat
i i3Document Detall,"Descrintion]
Document_Detail,"Desoiption3
‘GetSN{<Document_Detail "Dk gkt

Docurnent_Detail. "FromDocho"

- Document_Datal

A ITre @ Mae e, [Pae @ Decment L Moement © oc ment2{DnnomenDog

GroupFooter: GroupFooter2

"DetailData; DetsilDats2

i MeraeltemCode, "Descrintion” ]
[Mergeltem Code."D escription3"]

| MergeltemCode
TMamiay Msrr ernaTta, MAsey TsraaTharmy MasrasHisrm Masraathary MiarmaTta Ve

[GroupFooter: GroupFooter1 |

i) File -> Save As -> Enter Report Name -> Save
ii) Preview and see the result

Result:

DITUI JLINOAN UNL

DITTUI JLINTMN UNL

Attn MS JENNIFER Attn  MS JENNIFER

Tel 02-9864874 Tel  02-9864874

Fax 02-9864876 Fax  02-9864876

Customer Account Sales Executive Currency Rate Name Page No Doc No. Date

300-A0001 LF 2.503 ADMIN 1of1 1V-00026 19/01/2006
No  Description Qy Price/Unit  Discount Sub Total Toud Excl(g:; GS;,:T;M@) Tomidnct (GRSJ) Tax
1 D 9 UNIT 0.00 0.00 0.00 0.00 0.00

T4 015 16 0 A7 0 18 0 18 0 20
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5.2 Query to show Check Box either True to False
5.2.1 Click on CheckBox | Double Click OnBeforePrint

Report Tree &3 B

e e B e B e T

- A Memob4 ~
- A MemoS5
- A Memo&a R *GroupHeader: GroupHeader1 Main. Docho™
- A MmTaxRate B L L
- A MemogE -
- & SysMemo3d -
- A Memog9 N
- A Memo70 -
- A Memo71 N
A MmDuplicate R
- A Memog7 - F d 7 . -~
Ched@ox1 ol B Invoice Duplicate Copy
< > 1Billing Addrass TDeivery Address i
- r - 3
o [Main."CompanvHame"1] [ Main."BranchName"1
- A K 4
Eoied ieyecky & - [Main."Address1"] [Main."DAddress1"]
CheckBox 1: TirxChedkBoxView v [Main."Address2"] [Main."DAddress2"]
- [Main."Address3"] [Main."DAddress3"]
Properties /Events 3 [Main."Address4"] _[Main."DAddress4"] N
g:::;:i = TAttn [Main. "Attention"] Tattn Main."DAttention"] :
= o W] P " ™ B i M " T
OnBeforePrint CheckBox 10nBeforePrint r—TEl -\JME !I’].“F’hUI'I"El 1 +TEI -\JME!”'"DPhU”fl 1 4
OnContentChz Fax [Main."Fax1"] JFax L[Main."DFax1"]
OnMouseDowr i - L Ry —p— Touvency Rale TFrom Do Dele  Fram Dot Mo Thiame Toage Mo Do M. T D
H - k + + + + + + +
OnMauseEnter - [Main."Code [Main."Agent"] [Main."C [Document_ [Document_D [User."Cod [PAGE] of |[Main.”"Do  [Main."DocD)|
OnMouseleave T T T T T T Toal Bl Tar TacAnt T Total il Tax' Tax'
OnMouseMove L No  Descrigiion Q Price/Unil Discowi. S Toadl .2:"\ i .,‘L“ .2:’; ;
OrMauselp Z MasterData: MasterDatal ~ Main
g:::::::gtﬁ : *GroupHeader: GroupHeader2 Document_Detail, FromDocho™
B {Emm Dnr Mo - [Nncumant Datail "ErnmDochin™: Emm Do Date - [Namiment Natail "Erardl
DetailData: DetailDatal ~ Document_Detail
- 11 Document Defail."Description" 1 INany [Namy Macime [Nan Macument | Macument |, TNaciment [Nacimen, [Dog
N [Docum ent_Detail,"Description 37]
- GetSN{<Document Detall."DilKey" =]

5.2.2 Place a Query below

procedure CheckBoxlCnBeforePrint (Sender: TfrxComponent):;
begin
|if <Main."UDF updated"> = 'T' then

checkboxl.checked := true

else

checkboxl.checked := false;
A4 CheckBoxl.visible := <Main."UDF updated'"> = 'T"'
end;

Query :

if <Main."UDF_updated"> = "T" then
checkbox1.checked := true

else

checkbox1.checked := false;
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6. How to do Report Watermark?

Step 1 : Insert Band | Select Overlay

File Edit Report Wiew Help

LEEHC @&

T

Object Inspector

Fagel: Ti=ReportPage

Report Title

Report Summary

Page Header

Page Footer

12 013 0 14 0 18 0 16 0 17 0 18 0 19 0 20
1

/Properties YEvents Y Heacler FGroupHeader: GroupHesdsrl Main,"Dache”

BackPicture (Mot as: Footer o
BackPicturePrint v True | Master Data
BackPictureStet v True — R
BackPicturevisbl | True = HE@I LAt
BottomMargin - 0 4 Subdetail Data
Color WMol (5 Data 4th level 3 . Dol Cany
Columrs g | Data 5th leval Invoice i i
Dataset (Mot as — Biling Address Thdivery Address 1
Duplex dmmon |2 Data &th level JMain."CompanyName” | i
EndessHeight [ |False =7 Group Header [Main."Address1"] ;
Endesswidth || False [Main,"Address2"] [Main, "Daddress2"]

Group Footer [Main."Address2"] [Main,"DAddress3"]

[FFont (TFont; il [Main. "address4"] [Main, "Daddress4"]

i s e 3

FFrame (THrxFr At L IMain, "athention"] LAt J[Main, "Dattention " i
LargeDesignHeig v True Column Header ITeI jMa‘n,"Dphmem *
Lefttargin 0.99 Qi Besier JFax IMain.'DFax1"]

Mirroriargins [ |False oy Rt :Flum Do Datm :Flum [ :Nam: :vg »u T Mo, :

Mirrortiode n! Main."C [Document_ [Document_D _JUser."Cod [PAGE] of |[Main."Do  [Main."DocD,
Name Pagel Vertical bands T [ or T -, S T T h"(::‘;— B :;:‘: i I'"(RT:GTR:‘:
Crientation poFartrat MasterData: MasterDatal  Main
OutineText by "GroupHeader: GroupHeaderZ Docurment Detail "FromDocho”
PageCoLnt 1 Errn D e [0neoreent Oetal "EramDockin®l Eran Do Dats - [Narnsnt Detail "Eraee
PaperHeight 27.94 o 'DetailData: DetailDatal - Docurment_Detail
PaperSize Letter - 1 TGIDecurnent Detall,"Descrintion” ] & TP e Mina @ Mineme MM Morment - Mocoment - Toement Ponnme Do

Docurnent_Detail."Des oription3"]
Paperwidth 21.59 o GetSM{ <Dacument_Detail "DHKey" 1]
PrintifEmpty  WTrue V-
- GroupFooter: GroupFooter2
- 'DatailData: DetailDats2 1l MergeltemCaode
o 11 T MergeltemCode. "Descriction” 1 T Mlermiey TWsr, ThiernaTtay [arn, TerneTharny ThisemeThar, [ernaThern [erneTteMer
- [Mergeltem Code."D escription3"]
o [MGroupFooter: GroupFooterl 1

29



SAD\ Fast Report Basic Guide

EIAGET

e, SOIL, com.rmy

Step 2 : Insert Picture / Text to load in the water mark

File Edit Repart Wiew Help
DEBEC| D5 @] & D09 o) ¥ ¥ oo - | BEEE = s Tdd| s @ S
—T 6 -5 L u|m 4- [= = ==|mw wu

RMQhFcAaBELEzMbEEa=E@ = A =f
/Code {Data fPagel |,

Object Inspector @ 1 200 3 0 4 0 5 0 B 0 T o2 09 010 0 1 e 12 0 13 0 14 0 18 0 16 0 A7 0 18 0 19 0 20 0
Overlay 1 TrxOverlay ~ | - LN I Docurment Detall, "Descriotion” 1 I IPam wMaa o IPam e TMm L Mieenrent 1 Miee rmant L Haen mmrIr#r. |rmr’\]][;wt]
- ocurnent_Detail."'Desoription3”]
Q - GetSh{ <Daocument_Detal "Dtk ey" =]
/Properties | Events | _
AlowMiroriode | False = GroupFouter: GroupFoater2
Description - MDetailData: DetailDats2 | Mergzlterncode
[=IFil (T CustomeFil) o NN MeroelternCode, 'Descriotion”] Mhierne, Mier, MhiermeTre, Misra, [Meraeltern, [Wernelterm, [ernsTtem, [eraeTte,Mer
FI||GaD (Tﬁ’XFI\\GaDS) - [Mergeltem Code."D escription3"]
FIIIType fBrush © YGroupFooter: GroupFooter 1
[+Font (TFont) - TDomment_urrency. Desoiption”] : [Qurrency ToLangWord (<Main. "DocAmt"s, =
[HFrame (TirxFrame) = fpmﬁe' C“"E':EVLang > e = - . - -
Height 420 - + Total Amount Dus, [FarmatFloat, [FormatFloat, [FormatFlos, [Main,"Loc,
IndexTag a = et Toms | a1 T2 T Tewmard Total Pt
_ e " i . w . f— h
Left o N L.[rr\flam. Terms 1 L[Man‘ DocRefl”] ¢[Man. DocRef2"] $[I'=0r_ma_tFID“a_t$ [Main."DocAmt’ |
Name Overlay1 = s emEn 1 T izt Squand
parentFort M ¥ - [Documert_Cormpany. TaxExempthl P maybame'| (ot R T,
arentFon Tue o
PrintCrTop [ IFalse o
[#|Restrictions 0 _
Tag ] o
- Overlay: Overlayl
Top 21.90 - .
Wisible | True _
Width 19.96 o
-+
&
w0
=
o
=
~
&
_ PageFooter: PageFoater]
@
=
=2
o= =]
Centimeters  {10.00; 21.30 10119.96; 420 Crverlay 1

Step 3 : Overlay size can drag the same size as A4/Letter, and place the watermark on the
position you want to show.
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/Code | Data fPagel |

Object Inspector @ L L < - L L e I O 2 L 1T I - S B B ]
|Pienrez: Thxpictraview v
- M Document Deettéa_}l.lj‘lDDescr_\nt_\on;]. L MMamuMam . Mam macMao e Mecorent L Nacireent 1 Tnc reent Moo renDeg
; matyy! il Des oiption.
/Properties |Events | p ha Getsm(<D6cument,DetaR"Dt\Key"ﬂ]
Align baklone ~ -
AlowMrrorMode [ | False = GroupFooter: GrolpFooterz
AlowvectorExpe v True -
w TR MeroeltermcCode, "Descriction” 1 L Mherme, Thierm, Mernette, Thiern, ThiernaTtermn, TernaTtem, TernsTtem, MasrnaltagMer,
FJAnchors [fraLef‘t,fraTop] - [Mergeltem Code,"D escription3"]
AUtoSize [IFalse -
Centar IZITrue @ "GroupFooter: GroupFooter]
- TDomument_Currency, Desaiption"] : [Currency ToLangword(<Main, "Docsmt’s, 3
Cursor crbefauit . <Profie. "CurrencyLang”> 1]
DataField - - ! B - = - —
Diataset (Mot assignad) - T Tatal srmount Due, [FormatFloat, [FormatFloat, [FormnatFloa, [Main, "Los,
] 5 = = = = = 5]
— Papmed Teims e 1 er 2 Tan fmounl Tekal Pagatl
DSSCE"DUOH - L[Main“'Terms"j t[Man. "DiocRefl"] j[Ma‘n. "DiocRef2"] *[I’:Dr_ma_tFID:at* [Main." DocAmt"
GEdtble (] - o : .
FileLink. _ L[q_ncu-nent_[cmpmy‘ "TaxBempth - |Pofike; Campaneame’] ul:‘:r.’:"‘;:ssi"-tﬁ
EIFil (TfiwCustomFily =
=
FilType fiBrush _
[+Frame (Tfr=Frame) =
Height 350 - Overlay: Ouerlayl
Hightquality | |False o . ] ;i
Hint: -
FHyperlik (Thr<Hyperlink) o
KeepAspectRatic v True -
Left 0.80 = " "
Name Picture2 -
Pictre (Fictre) B
Printable W True - e . a
o
[+Restrictions 0 b o
.
N
_ PageFooter: PageFooter]
=
=
Step 3: File | Save As: Enter report name
Step 4 : Preview and see the Result :
=]

EEE&~ B @ = H -

3 Arbiacnnl Tremongery Lod

Testing Co. suswses;
s
SOILN, 070 Skah klam, Selangoe,
RN Frore: 037347 10 Fax (35989215
CINe: BIE- 120N
Invoice
e T
M Housing (Langhcam) Sda. Bbd.
Lot 55, Jdar Msriar K, Lok 38, s WiertariKiuzh,
000 Langhns i
B e Debs s o Dok
Te o Td wews s
Far
e vcao oo oy Tus oo asosaon
— p— PSP T
1 Fosdond oA Cdic 2Swa0 S Snao0 am0s
b as ]
2 o led Due 700 S SAmnn 2mm w00

Tod st

Alar

Frogpeery s 7smo0 7swos
Lrcsen ooty
T30 000 zas08
T e
299,500.00
eSS

Page10f1

Sales Invoice 8 (ST 1) - watermark
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Frequently Ask Question(FAQ)
1. Unit price is 0, display as FOC
In Memo, enter following syntax :

[FormatFloat(',0.00;-,0.00;FOC ',<Document_Detail."UnitPrice"> )]

Memo (il
=)

Text  Format Highlight Data | Variables | Functions | Classes
x5 = T= [ —
Aé hd 1 lE IFl <]

Disc

Eed X
* v

[FormatFlost(',0.00;- 0.00;,FOC ' =Document_Detsil "UnitPrices 3]
Sen

| Description

| StockGroup

| Descriptionz

| Remarkl

| Remark?2

| Description3

| Localdmount

| LocalsmountyvittTax
Qty

| Amount

| ArnountitTax

T B B B T BT T [ [ B[] (o
=RE = R = R = R = R = R Rl =

Ok Cancel

2. Document Currency Description Cents change to Sens
[Document_Currency."Description"] : [StringReplace(CurrencyTolLangWord(<Main."DocAmt">,
<Profile."CurrencylLang">), 'CENTS', 'SENS', TRUE)]

-g Memo aTx)
Text  Format Highlight Data | Varia.. |Fundi.. | Class...
_ 57 == T

B 2= 2N T = E

:Documem_Currency."Descr\pﬂon"]: [StringReplacerCurrency ToLangviord( <Main."DocAmt"=, <Profie "CurrencyLang"=], 'CENTS', "SENS', TRUE)] 0] LocalAmaournt

v | pl_TaxRate

=

| Dockey
10 Tax
0] TaxRate

I v | pl_MergeSerialNui

| Dockey

| emcCode

Uam

| UnitPrice

Diisc

Tax i

2 =) =] =] =] =] =

oK Cancel e —— b
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3. More Description convert RichTextToPlainText
Syntax :

[RichTextToPlaintext(<Document_Detail."Description3">)]

CECIEE -1 - |
i i i

=3

[RichTextToPlaintesxt(<Docurnent_Detal,"Description3" )]

----- Description
StockGroup
Description2
Remark 1

----- Remark2

----- Description3

- LocalAmount

- LocalAmountWwithiTax

AMoun:
] - o x IO eTalx) (=)
- 00 : B8B0~ 05 i ™3 00 :B8BQ~ O = =
Edit
=3y Testing Compam coconoce e s aen =) Testinn Compamy cocoonoos s snncisas Defete
7 D)) 1, 1dan Setia Diagang AX UIHAK, Z D) 1 e sens Dagang AK ULWAK,
7/ Setia alam, 40170, Sheh Alam, Selangor —_Z# Setia Alam, 40170, Sheh Alam, Selangor =
Fhone: 03-78501 300 ~ Phone: 03-73501 300
Email: sdes@S0L com my Emal sdes@SQL com my
Invoice Invoice
[Foreiey Ty Al heaAdies Ty et .
CASHBALES CASHSALES Browse
am atm am am
Tel Tel Tel Tel
Fax Fax Fax Fax
T G e e G G = e
300-C002  — ADMIN 1lofl -00022 20/12/2022) 300-CO002  — ADMIN dofi 00022 20012/
o tmcinion a [o— PRI o s o temcipian " [r— satad L T A
1 Comative Curvy Macks Sty Eanes Chir 1D UNIT B0 ®m  mm  om  ®m 1 Costve Curvy Modken St Gares T L0 T S50 ®m =m  om &
Speaficatan ;.
Color : Gray
& Matenal ; oo
Miterial : Wood
= ASASUSUSAE UEIURUASZAS
D e o
Tose
Page 1of1 20.12.2022 18:04:00 Sales Invoice 8 (SST 1).1r3 Page 1of1 20122022 1804:11 00Sales IV

4. How to change report paper size?
File -> Page Setting ->
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ﬂage Up%ons x‘

Faper (ther options

Size

[ |

flLetter v
Statemertt
Executive I

T Langscape

rarging

Left 0,33 N Right 0.25 N
Top 0,25 N Bottom 8] in

Faper Source

First page Defallt R7
Other pages Defallt R7
8¢ Zancel

5. if Qty > 10, text color in red and in bold?

5.1 Double Click on Memo
5.2 Click on Highlight Tab

5.3 Click on Add Button
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5.4 Expression value > 10

[ TuN

fDataYvaﬂabmsYFuncﬁonsYChsses\

Q- | T | B @

..... Iﬂ StylelD

----- Murmber
----- ItemCode
----- Location
..... Eateh

----- Project

----- Description

..... Kinne)
----- UnitPrice
----- Amount

Expression. L

valus > 10

(94 Cancel

5.5 Click on Font
Can set for Font Type, Font Style, Size, Color or Effects
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é Font

X

Font: Font style: Size:
Avial | Bold 13 oK

i 8
Narowbodtal | B |
Arial Rounded MT [j I o I
Bahnschrift \Bold Italic 1 ;
Barlow Black I 14
Baskerville Old Face Black Obliqe 16
Effects Samnple
|| Strikeout
[ Underline AthYYZZ
Calor;
I Red VI\L Seript:

= Western
5.6 Press OK

5.7 Right Click on Memo, Ticked Allow Expression

Result :
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Testing Compam cocsoiocess 110530
1, Jalan Setia Dagang AK U153/ AK,
Setia Alam, 40170, Bhah Alam, Selangor.
Phone: 03-78901300
Emal: sdes@3 QL. com my

Invoice
Eilling Address Drdiwary Address
CASH SALES
At Atin
Tel Tel
Fai Fau
CElame Aot Sl Enmotom Mame Pag= o D= k. Dty
300-coo02 - ADMIN 1ofl 1v-00022 20/12/2022
- . , Tekal Bzl Tax Tan Am! Tekal Irel. T Tas
Mo Deciépton oy Pricefunt Dot S Toual 0 i U“"l; a (Rm
1 Creative Curvy Modern Style Earmes Chair 12,00 JMIT 25,00 1,020.00 1,020.00 000 102000
(Grey)
Spedfication
Color : Grey
Material @ Wiood
2 Premium Fabric 3 Seater Sofa 200 JHIT 1,300,00 3,000,00 3,000,00 000 300000

6. Why in Report I have place at the position I want, but when preview it will

show at bottom?

- Right click on Memo, unticked Shift and Unticked Shift when Overlapped
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7. Export to PDF Logo is blur
Solution :

GroupHeader: GroupHeader1

o8 L] a

=

L] Edit...

Aufo Siz
v Stretch
r“’ v Center .
S a I e: Keep AspectRatio
£ Shift =

Billina Add Shift When Overlapped

e

[Main.| v visible
[Main."; v Printable

[Main.”s ., cut Ctrl+X
[Main-"'j ] Copy Ctl+C
L[Main-"‘ — | Copy Content Ctrl+Alt+C
:Attj [j Paste
LTeJ > Delete
:Fa : Select All Ctl+A

Select same type on Parent =

r | | r hl
Customer Ac Select same type on Page ite From Doc Date

TMain." . 'C’ ITDocument
| Bring to Front
" No | Item ™ Send to Back ’

~1.54; 1.82 DBImage3: Profile."Logo"

8. How to capture remark1 as url path?
In Memo properties :
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Hyperlink Expression added in the Data Field Name

cade | Bata Page1
Report Trez B
A Memos2
29 pagarooterl
~ 1 DetalDataz :
5 symemoz &
A Memol7 -
A Memozs | H

A Memoz?

A Memozo

A Memo1

| &] richDescam

A MmDesth 3

Object Inspector
[Memos2: Tiemoview

[Properties  Events | Faverites

[EHghight (Thskaghight) | i
HIt
(TirxHyperirk) =

Result :

e P O PPN P PP IR
h:|:|-|‘,oice ! Duplicate Copy‘

Bl Adkress Devery Ackress ,
F[Haln."(:ompanyllame"] ’[Hah."rannilhme'] X
[Main."Address1"] [Main."DAddress1"

Main."Address2"] [Main."DAddress2"

[Main."Address3"] [Main."DAddress3"

[Main."Address4"] [Main."DAddress4"

‘Attn [ Main."DAttenticn"
Tel [Main."Phone1”] el [Main."DPhone1]
Fax_[Main."Fax1"] Fax_[Main."DFax1"]

Cetcamis Aot S B Comency fte _Fiom DocDate _Rombocho e P 10

4

‘Attn [Main."Attention"

f
™ T ]
rlhlcllahl."Doc [Main."DocD|
3 a2

ment_Detail."FromDocho

[Main."Code™] [Main."Agent [Main."C [Document_ [Documen [User."Co [PAGE] of
T Jtem Code Dascrotion Oty

IGroupHeader: GroupHeader 2

P S

i rmfn— ——s nifionment Detall Miserrintion”]
Document_Detall ,'D&xr?ﬂnﬂ 1
GetSN(<Document_Detall. "Dtikey">)]

“Document Detsil "Remarki”]
by . .
GroupFooter: GroupFooter2 |

Data Tree x

Data van.. Fun.. {Cl

@3- | FTIE
5] Dockeys

Ameunt

8] Localkmer

0 Qty
~ 1l pl_pisc
Dockey
Amount
Localtmos
QY
axRate

T
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Testmg Comp ALY om0 ses (511006-M))
1, Jalan Setia Dagang AK U133 AK,

Setia Alam, 40170, Shah Alam, Selangor,

Phone: 03-78901300

Eail: sales@SQL.com my

Invoice
Eilling Address Ddivery Address
THAI TEA TRADING
Mo 43, Jalan Batu Tiga Klang, Mo 43, Jalan Batu Tiga Klang,
42000, Pelsbuhan kKlang, Selangor. 42000, Pelabuhan Klang, Selangor,
At M. Leonard At Mr. Leonard
Tel 03-3216 1027 Tel 03-3216 1027
Fax Fax
Omtame Aok, Sak= Enmoulive Hame P Ho Doz ko, (1543
300-TDOO1 Yuki ADMIN 1ofl I¥-D0001 11/06,/2022
o Item Code Deccni plian oy Price/ Lo Sun Total (RHY
1 RFC/ElLe Ultra Soft FLffy Rug Rectangle Carpet (Be) 10.00 UNIT 4000 400,00
Click will auto link to this website
WWWSQ.CDH‘I.[ Tty
2 RFCjGreen  Ukra Soft Fluffy Rl.{g?Rectangle Carpet (Geen) 10,00 URIT 40,00 400,00
RIMGGIT MALAYSIA @ EIGHT HUNDRED CRLY Grass 200,00
- Digcount 0.00
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9. Payslip to show AL or MC Only
Step 1 : Click on SubReport3
Step 2 : Right click on Leave MasterData Band

[code (Bta pager Subreport’ (Subreportaf SibreperT] o
Report Tree X Fy b L bl Be et Be b Tos BB Dk AT 2 ] 5ot AT B eeetev A8 i Q0o Zhesr 2 DataTres x
v e | Data arisbles | Functions | Classes |
A LesvaLesva: : IHeader'HmcEﬂ G- mE @& F5)
Atewsrvas | I MllemeTe [ BE Enile YD MID  Eal ] Logo )
A LesvaTaken ]| T v [0 user
A LesvaBabnce |~ M| eave "Descripl:. BFDays"] Entitie' Te Y TD"] 2. " Taken"] 'Balarce'] ‘ 0] code
A LesveEntit B |Hem Teader3 1 78] name
: H - - & Ra Ty e o s
Object Inspector X 4 L0 sActve
o o [Overtime "Des [Overtime."W_ [Overtim, [Overtime."P_ [Orertime "Am v [ option
7 o : time. ertime.” m ertime.” me." —
|Proper.. |Events Favarit. | % Header: Feadas £ FayrolvaueDisplayFormst
MowMrrortvod_ Fabe B I : . . . " RatsDsplayFormat
Mowspit Fake | | Pay Year Description 1 Amoinit, i 8] RatsRourdngfrecsion
;ﬁmm & 1 ") workUnitbsplsyFormat
Comre O H "PayYe ‘Description”] [Barus.“Amcun, " DayDeplayFormat
Cobmnwicth 0 ¢ M [Header: Headré o [ plevairpl
DataSet Leave < " - . - - | '
Description H Pay Year Destription 1 Amcent, (s8] Subject
o Trce | ImesterDatar Mesirbatar T T T | S
(BT oflca | 3 - - . . 3] pOrpassword
FilType fBrush H | _[D\“r_eclm ‘Pay't _[Dlrector. Description] ‘[Dkscmr‘ Am% | 3] POFFietame
Fiter (eLeave’ | -
ot ) : |I:Ieads-:l—hads7' . . Gl ee
Foovraftergacl Jrake oWiDate  Desopon Awent | 0] Bcc
B w1 piTLeaveDay
é N i) eas "T_1 naicd saves Tesrrintion™ 1 Inraicdl pawve ", «0] Employee 1
: 0 Tleaveday

Step 3 : Click on Filter button

Step 4 : Enter the expression :

(<Leave."LeaveType"> ='AL') OR (<Leave."LeaveType"> ='MC')
Step 5: Press OK

Step 6 : Press OK
,I'DataWanables\{Functlons\‘:classes\ = = ‘ Wi Do,

=i =0E
@i- | ™iF | B@ Ol
> -1 TaxBenefitHistoryDetail A
5 | 1 TaxDeductionHistoryDetail
v |0 Leave Select DataSet %
Employes
Drataset
= LeaveType —
Description L_j Compensation
CP38
[0] Entle l_j . I
|4 Deduction
L8] BrDays | Director
Ly | Employes
Taken
Balance
- ) [&]
> -1 1 LeaveAttendance Mumber of records: 0 =
Expression:

Filter
(<Leave. "LeaveType"> =TAL") OR (<Leave."LeaveType"> =TMCT)

o —O
6-&_ | [T o—&_| Ceaed
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10.How to get Net Unit Price
Step 1 : Click on Memo Tex

Step 2 : Place on Document Detail Band
Step 3 : Drag data field from right to left box :
[<Document_Detail."Amount"> / <Document_Detail."Qty">]

Step 4 : Press OK

Step 5 : Adjust the position
Step 6: Preview and see the result

File Edit Report View Help

DaHE UEs s« Db 9

Mostle v atal

| X 1| B 100% ~
-8 B 1 u|® A-m 9|E = = =

9| 1 e | T | b F @ F AR
Wowou | TEHOADHE|2-ag=m -

e ﬂg?u_'.tMjndjdmﬂ:\-lﬂuue]ﬂi!.g?j@{!'“

Cade | Data | Pa

T
ReportTree x T, e BT o s as o mmemom e w
A Memosa Text  Format Hghight Data | varizbles | Functions | Classes.
=1 PageFooter1 =2 E= @it | M | D@ fs]
= CetaDaaz o [t Dottt 1 <Docmmart Detot b1 - L:0] Batch -
E SysMemo2 o 0/ Project
A Memo17 - 0 Descripton
A Memo2s - o] Qo
A Memo2? - ' WG] UoM
A Memo2a - 3 UnitPrice
A Memo2s = 5 amourt
A Memo1o - 3 Printzble
- - - [10] account
q = [8) Stocktroup
Object Inspector x: - —
2ol ihs i L] 23] FromDechate
Memo3. Thxtemew B (i > T Famp
Properties | Events | Favarites = o e 8] DeleryDate .
ARn batione _ — -
AlOWEXpressos e || m""‘"" ‘*‘““““" ] = ; \ Doasment,_Detall, Frombocto* |
- i b - Moy evant Detd e o™t_Fom Poe Dt - [Mon et Detal FnafioeTuts” b
MowHTMLTags Fase -
AlowMiorhtode Fase M "o et Tesccton | S et Decumat e £
AlgwvectaExport  @Te B [ty Delal"\:rﬁxa"ﬂ]
Elenchers [FaLeft B e
AWt Fase =
Carsnimic Fase -
e - e
. or v
- Tooeument,Currency. Tescrition”] : [Cuvency Tekangiord(<iein, TocAmt ™, <Profle, Currencilang™>1]
Cantimetars [ U8.50; 12,70 17250;0.50 Memo&:

3700330 3

- DataTree x
/Bata | ariables | Functians | Classes.
@3-

—iE
0 TRt
[ Taxamt
0] LocaTaxamt:
~ |1 FromboccCount
[ hos
~ 11 adiRound
(8 Dockey
[ amourt
(58 Locaamount

B

w |1 pl_TaxRate

(8 Dockey

[ Tax

[0 TaRate

~ |1 pl_MergeSerialNumber

[0 Dockey

[0 KemCode

[ uom

T uritprice

[ oc

) sensbinoer |

11. UOM = UNIT, Qty display without Decimal Point, else with 2 Decimal Point.
Step 1 : Click On Memo Text
Step 2 : Copy the below syntax and Paste into Memo:

[lIF(<Document_Detail."UOM"> = 'UNIT'>,
FormatFloat('#,0;-#,0 ', <Document_Detail."Qty">),
FormatFloat('#,0.00;-#,0.00 ', <Document_Detail."Qty">))]
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Text  Format Highlight
[T

-

[IIF{ <Document_Detail,"U0M" = = 1UNIT =,
FormatFloat(#,0;-#,0", <Document_Detail,"Qty" =) ,FormatFloat(#,0.00;-#,0.00 ",

| <Diocument_Detail."Gly")) 1

Ok Cancel
Step 4 : Press OK
Step 5 : Result After Preview
Testing Company qosoimases e11016 b
1, Jalan Setta Dragang AK 13/ AK,
Setia Alam, 40170, Shah Alam, Selangor,
Fhone: 03-73901300
Email: sdes@SQL com my
Invoice
Billing Address Drdivery Address
A HOME FURNISHING 8 SERYICE
Lot 93, Jalan Mentari Kuah, Lot 98, Jalan Mentari Kuah,
SO4a0 KL S0480 KL
attn Mr. Delta attn Mr. Delta
Tel 04-976 52325 Tel 04-976 5235
Fax Fax
Omstome Aooount Sak= Ewmoulive Hame= P Ha Doc Mo, (150
300-A0001  Yuki ADMIN 1ofl IV-00026 10/09;/2023
Mo Desciiption oy Picerlint  Discount St Tetal 0 EIEL(I:J T""‘&T,B Toal I"‘"(I:I’J‘ ;
1 Preriumn PU Leather Ultimate Garning 1 JUMIT 700 700.m 700,00 0.0m 700,00
Chair (Elack)
2 Prerium PU Leather Utirnate Garring 1o TN 0. 0.00 0.0m 0.0m 0.00
Chair (Elack)
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12.How to Get Supplier Bank in Payment Voucher?

Step 1 : Click on Memo -

Step 2 : Paste this syntax inside Memo
[GetbankName(<pl_SUPPLIERBANKACC."Bank">)]

'amemo D'XJ
Text  Format  Highlight
gl £ =
- - =
“GetbankMamel <pl_SIUPPLIERBAMKACT, Bank™ =]]
oK Zancel
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13.How to change the Amount in Word to First Character to Upper Case only?

Can use function NameCase

-'a herna =LE
| Text  Format  Highlight
T

- v

|
|
|
I [Crocument_Currency "Crescription] : [ BEIGEEERS Currency ToLangord( =Main."Cocamt" =, =Profile."Currencylang"=]]1]

Ok Cancel
Before :
Ringgit Malaysia IONE HUMNDRED OMLY I Grass 100,00
- Discount 0.0
Total Exd. Tax 100,00
Tan Amt @ 0.00
Rounding Adustrment 0.00
Total Payable Incl. Tax 100,00
Papmed Teims el 1
45 Days 2222
Ao iged] Fgnalue
Testing Compamy - Cunent, Use ()
After :
Ringgit Malaysia §0ne Hundred Only
Total Arnount Due 100,00 100,00 0.00 100,00
Paymer Teims Rl 1 Tas Amoun (RH) Tekal Paapatke (M)
45 Diay's 222e2 0.00 100.00

furimized Sgnatuie
Te=ting Cam pamy - Cunenl Use ()
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14.Long More Description cause report first page is Empty

Step 1 : Right click at Detail Datal > Ticked Allow Split

File Edit Report View Help

E I T 1 - e

Edit...
Add child band

T Tahoma 9 - B [ U | r A-@3 P | = =z, Stretch
I Allow Split
%ﬁtj@ﬂ = _JH o of ol | e =|:-‘ 4] EH = }i| Keep Child Together
DEEE| e S 4D W | | 100% .| Print Child If Invisible

AR Q L F=faELE:=zVMikEESS = @ oo 258 StfartNewPége
/code | Data | Page1 ! Print If Detail Empty

Footer After Each Row

200

Object Inspector LA 1 20 3 0 40 5 0 60 T8 P16 0 17 18 0 19 0
: o Keep Detail Together
DetaiDatal: ThrxDetaiData | . L .
Invoice Keep Footer Together Duplicate Copy
’ -
}rPropert\ \{Events\(Favorltes\ . EFrah Keep Header Together
AllowMirrorMode | False B o 1
. JMain."CompanyName"] a; C CtrieX T
Allowspiit || False _ [Main."Address1"] ut tri+
Chid - [Main."Addres<2"] _ | Copy Ctrl+C
ColumnGap 0 [Main. Aggresﬂ] EI] N CtlAlteC
- Main."Address4" opy content tri+Alt+
Columns 0 - r[ L ! ral > 1
ColumnWidth 0 Attn [Main."Attention"] |-_| Paste Ctri+V -‘
- Tel [Main."Phonel"]
Dataset Documen - Eax ﬂMam."Faxl"] < Delete 1
Tiption - Colone Acosl 58S Beodive | Cuvewy Rdle | Fram DI DBt Select All Ctrl+A
[=IFill (TfrxCusty | | & = o R L + - Se——
CIFiGap (TfrxFilGa ~ [Main."Code [Main."Age [Main."Cu [Document_D Select same type on Parent in."Docho” [Main. "DocDa)
- Taxamt  Total bdl. Tax Tax
FilType ftBrush = e Dmore —™ Select same type on Page X @, ), Bate,
Fiter - e :
Font (TFont) ha FGroupHeader: GroupHeader? % Bring to Front rocument_l}etail."meDocNo"|
FooterAfterEach| | False - [Emm Dinr Mo+ [Dacument Nafail "EramNackiin™ls Emm Dr % Send to Back H
[+ Frame (TfrxFram = . - >
Height 1.00 ; Hul m_ﬁgggﬂmsgé[gfglﬂﬁgsssgzggmﬁ j]'nnrurm_ INnc MNncime TP MNnciment L MNacomant o TRncoment, FRnmimantstsly
IndexTag 0 - GetSN(<Document_Detail."DdKey"=)] .
KeepChid [ ] False - GroupFooter: GroupFooter2
= -
- 1T MeraeltemCode.” Description”] AMarnaliMara M Marnafa TMarn TMarnafrarmy TMaraaTtam TMarnatramy TMernata Meg
w MergelternCaode. D escripion3”] H
'_' [GetM ergeSN{< pl_Merg eSerizlNumber."ltemC
- FGroupFooter: GroupFooterl
- TRammant Cureanme "N A" s Frurranm Tl anmAnedl «Main "NasAee"s_Deafiln I

Step 2 : Click on DetailDatal > Properties > Event Tab > Double Click on OnAfterCalcHeight

[Code (Data /Pagel
Object Inspector X x iy P10 20030 40 50 B 0 T B 9 1100 110120 130 140151 161 17 0 18 1 191 20 + 21 1221 23+ 24 4 251 26+ 27 1 28 1201 30 + 31 1321 33+ 341 351 361 37 1 L
23" Double Click
[ DetaiData1: Th Step 2 21 Step 2 3_Double Cici g ‘ :
Duplicate Copy

Ty

JMain.“Branchiame"] =]

[Main."DAGdress1”]

| oneforepmt  DetatData1 OnBzforeprnt
| OnMasterDeat

[Main."DAddress2']
{Main."DAddress3']
{Main."DAddress4"]

“ttn JMain."DAttention"]
| ITel SMain"Phone1™ Tel Man."OPnone1"

| YPox TMam Py Fax liMan0Fea"

| '{Main"Code '[Main."Age [Main."Cu'{Document_D Y[Dociment ‘[user. “Code™(PAGE] of [{Main."Doctio™ Main. “DocDal
T L

Document Detad ‘Descrotion] 7
ocument_Detail Descroton]
S <Document_Detai. D8Key™>)] ¢

rotion’ | b
MergeltemCode. Descipbon 3]
epesen

<
eseratiombes ame {

i tieosRenCode.Des
3

2P rrMRI e
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Added // infront of if statement

Code (Data | Paget
Object Inspector x

X language: Pascalsript -+ EE| ¥ EE 0 8%

DetaiDatal: TirxDetailata D¢ If Trim(FDN) <> '' then

Propertias | Events | Favorites &1 ‘From Doc Ho. @ !4 EDN ® 15 else

(OnAfterCalcHeig talOnAfterCaicHeight = | | 7 i Vo

OnAfterPrint A € "0 Then

OnéeforePt - DetalDatal Onbeforsprint | 4 am. Boc Date : ° + EDD slse

OnMasterDetal A
A GroupHeader2.Visible := (VarToFloatDef (<FremDocCount."Nos">) > 1) and (<Option."MergeSameItemCode"> = False);
A Document_DetailFromDocNo.Text := D + DD;
A end;
A
Al
r : TfrzComponent) ;
Fa -
ol Mple Stop position on 9.5 2
T if TfrxDetailbData{Sender). sngine.Cur¥ + DetailDatal.Height >= 912) then Engine.NewPage;
.
N
A procedure PagelOnBeforePrint (Sender: TfrxComponent);
- begin

OnAftercaicHeight N ShiftRelative([MmDesc, RichDesc3, RichSN1);

A shiftRelative ([MmDescM, RichDesc3M, RichswM]);
A

Step 3: Set Stop Position

Click on DetailDatal > Double Click on Page1OnbeforePrint

Code | Data (Page)

Object Inspector XX language Pascalscript ~ WH| » 3TWE e G

DetaiDatal: TrxDetaiData | end;

Properties /Events | Favorites » Rt s SEndst TR aRe

OnAferCak DetalData1 OoARe oo procedure DetailDatalOnBeforePrint (Sender: TfrxComponent);

OnAfterPrin begin

OnBeforePs DetalDatal OnBeforePrint |+ DetailDatal.Visible (<Option."MergeSameItemCode"> = False) and (<Document_Detail."ItemCode"> <> '

OnMasterD DetailData2.Visible
// For Print Count 20

//if TfrxDetailData(Sender).Visible and (<Line#> mod 20 = 1) and (<Line#> > 1) then Engine.NewPage;

(<Option."MergeSameItemCode"> = True) and (<MergeltemCode."ItemCode"> <> 'RTN!

if Engine.FinalP
if <PAGE> <> <TOTALPAGES> then
PageFooterl.Height :=
else
PageFooterl.Height :=

end;
end;

procedure GroupHeader20nBeforePrint (Sender: TfrxComponent);
var D, DD, FDN, FDD: String;

begin

<Document_Detail."FromDocNo">;

:= <Document_Detail."FromDocDate">;

If Trim(FDN) <> '' then

OnBeforePrint 1

Add below Code inside procedure DetailDatalOnBeforePrint(Sender: TfrxComponent);

if Engine.FinalPass then begin
if <PAGE> <> <TOTALPAGES> then
PageFooterl.Height := 150
else

PageFooterl.Height := 0; //height on 0.3 inch * 96

end;

D.. x

s

47




